
Introduction to ArcGIS® Pro 

for Planetary Science 

Exercise Workbook 

Presented by the 

Spacecraft Planetary Imaging Facility (SPIF), Cornell 

Sponsored by the 
Planetary Data Training Workshops 
NASA Topical Workshops, Symposia, and Conferences 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 

Lead Author 

Zoe Learner Ponterio 

Manager, Spacecraft Planetary Image Facility (SPIF) 

Cornell Center for Astrophysics and Planetary Science 

 

Collaborating Authors 

Sayed Najiullah Basharat & Nina Ellison 

Cornell Undergraduate Student Assistants 

 

The Planetary Data Training Workshops Team 

David Williams (PI) & David Nelsen 

Arizona State University, Ronald Greeley Center for Planetary Studies 

Alexander Hayes 

Cornell Department of Astronomy, SPIF 

Marc Hunter & Sarah Black 

US Geological Survey, Astrogeology Science Center 

Shane Byrne, Christopher Hamilton, & Brett Carr 

University of Arizona, Lunar and Planetary Laboratory 

 

Additional Authors of the ArcGIS® Desktop Edition Workbook 

Nick Gershfeld, Anjali Rajesh, & Revati Athavale 

Cornell Undergraduate Student Assistants 

 

Trent Hare 

US Geological Survey, Astrogeology Science Center 

 

Acknowledgements 

We thank NASA for funding the Planetary Data Training Workshops (PDTW) under the 

Topical Workshops, Symposia, and Conferences (TWSC) program. We also wish to 

acknowledge the former Regional Planetary Image Facility (RPIF) Network, of which all 

the PDTW institutions were part of, for its 44 years of dedication to preserving the data, 

knowledge, and skills of planetary science and NASA space mission operational support 

and data utilization. The RPIF Network established the collaborative relationships 

between our institutions and employees, which we have continued beyond the ending 

of the RPIF program. 

1 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 

Table of Contents 

 

2 

Introduction 

        Lecture Slides  ................................................................................ 3 

 

Chapter 1: Project basics 

        Exercise 1: Getting started in ArcGIS Pro  .......................................... 13 

 

Chapter 2: Working with rasters 

        Exercise 2A: Loading, exploring, and symbolizing rasters  ..................... 29 

        Exercise 2B: Raster analysis  ............................................................ 45 

 

Chapter 3: Working with vector data 

        Exercise 3A: Creating and sketching features  ..................................... 59 

        Exercise 3B: Editing and finalizing features  ........................................ 64 

        Exercise 3C: Importing shapefiles and using selection  ......................... 67 

 

 

Chapter 4: Criteria analysis 

        Exercise 4A: Converting rasters to vector data .................................... 81 

        Exercise 4B: Using overlay to find landing site areas  ........................... 83 

 

Appendix 

Common File Types  ....................................................................... 94 

Main Components of the ArcGIS Pro Window  ..................................... 95 

Ribbons  ........................................................................................ 96 

Glossary ........................................................................................ 98 

         

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



Introduction  
Lecture Slides 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



    

 4 

 
 

 

 Introduction 

Lecture Slides 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



    

 5 

 
 

 

 Introduction 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



    

 6 

 
 

 

 Introduction 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



    

 7 

 
 

 

 Introduction 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



    

 8 

 
 

 

 Introduction 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



    

 9 

 
 

 

 Introduction 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



 10 

 
 

 

 
NO

T 
FO

R 
DI

ST
RI

BU
TI

ON

spif@
astro.cornell.edu



 

Exercise 1: Getting started in 

ArcGIS Pro 

 

Project 

basics 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 12 

 Chapter 1: Project basics 

Chapter 1: Project basics 

 

Introduction 

In this chapter, you will learn the basics of ArcGIS Pro Projects. You will see how the elements 

of a Project are organized and presented, and how to view and explore Maps. You will also learn 

some of the main differences between the ArcGIS Desktop suite of applications and the single 

application ArcGIS Pro, and how to import data created in ArcMap. 

 

Objectives 

 Create a new Project 

 Become familiar with the structure of the ArcGIS Pro window 

 Explore data in the Catalog pane 

 Import a map document created in ArcMap 

 Explore Maps in the View pane 

 Edit layers in the Contents pane 

 

Terms  

 Attribute Table 

 Bookmark 

 Folder Connection 

 Geodatabase 

 Layer 

 Map  

 Project 

 Quick Access Toolbar NO
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

Exercise 1: Getting started in ArcGIS Pro. 

  

Main components of the ArcGIS Pro window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

. Adaptive Tabs that change depending on what type of data you are viewing or have selected. 

 Tab Ribbon and Tool Groups appear with relevant tools for each of the tabs. There are no longer 

toolbars that need to be opened individually. 

 The View Pane is the main workspace where you can view elements of your project, such as Maps, 

Tables, Local and Global Scenes, and Layouts. 

. A Map displayed within the View Pane. 

. This shows the map scale. You can change it from the drop-down menu next to it or by typing 

the scale you want. 

This shows the position of the cursor in the coordinates of the map. You can change the units 

shown here by clicking on the drop-down menu to its right and selecting your desired units.  

. An Attribute Table displayed within the View Pane that shows data associated with a Map 

layer. 

 The Contents Pane contains a list of all the layers in the Map. 

The Catalog Pane is where you manage, organize, and access your geographical data and Project 

elements. 

A layer is a displayed set of geographic features with the same type of geometry (point, line, 

polygon) or a raster (image). NO
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 Step 1: Setting up ArcGIS Pro and creating a new Project 

 Start ArcGIS Pro, click on Settings, go to Options and then click on Map and Scene. 

Under Basemap, if it is not already, set the Map and Scene to None. This menu can also 

be accessed once you have started a Project by clicking on the Project tab and then clicking 

on Options. 

  

 

 

 

 

 

 

 

 

ArcGIS Pro is set to Earth by default, and so it will load an Earth basemap and coordinate 

system to any new Maps you create. By clicking None, Maps will have no initial basemap. 

You can then set the coordinate system manually, but more commonly it is set by the first 

layer you add to the Map. 

 

 Click OK, and then click New from the menu on the left. 

 Click on Start without a template     . 

 In the upper left corner of the window, click on the Project tab, select Licensing, and 

check if the Spatial Analyst extension is licensed. If it is not, there are two steps in the 

exercises you will not be able to do. In that case, there will be instructions on how to access 

the necessary data.  
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 Click on the back-arrow at the top of the menu on the left to return to the Project window. 

 If you do not see the Catalog pane on  the right of your screen, click on the View tab at 

the top of the window and click on Catalog Pane. 

 

 

 

 

 

 Expand Folders in the Catalog Pane.  

 

 

 

 

 

 

 Right click on Folders and select Add Folder Connection     . In the Documents folder, 

navigate to the ArcGIS folder, where you put the ExerciseData folder. Select the 

ExerciseData folder by clicking on it once, then click Ok. 

 

When you start a new Project, a default Untitled folder and a connection to it is 

automatically created. Generally, you will have data in a folder you want to work with and 

will not want to use this default folder. 

 

 Right-click on the ExcerciseData folder and select Make Default. Then right-click on the 

Untitled folder and select Remove From Project. 

 

 

 

 

 

 

Any time you “remove” something, this does not delete any data or files. You are indicating 

that you no longer want to see the data. 
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

Step 2: Import an ArcMap map document into a Project and 

explore it 

 In the Catalog pane, expand the ExcerciseData folder connection you just created. 

 Expand the Chapter1 folder. Right-click on JezeroNili.mxd, a map document created in 

ArcMap, and click on Import And Open.  

 

 

 

 

 

 

 

 

 

As with folder connections, when you start a new Project, a Default geodatabase is created. 

If you have been given a geodatabase to work with, you can change that to the default 

similar to how you changed the default folder connection. 

 

 In the Catalog pane, expand the Chapter1 folder and right-click on the JezeroNili 

geodatabase, and click Add To Project. 
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 
 
 In the Catalog pane, expand Databases, right-click on the JezeroNili geodatabase, and 

select Make Default. Right-click on the Default geodatabase and select Remove From 

Project. 

 

 

 

 

 

 

 

 

 

 

 

 

We have to go through this process because Default geodatabases cannot be renamed.  

 

 If the Contents pane is not already on the left side of the screen, then under the View tab 

click on Contents.  

 

 

 

 

 

 

Notice that the NE Syrtis Basemap layer has a  

red exclamation mark next to it. This indicates a  

broken source path, which means the Map is  

looking in the wrong place for the data it needs to  

display the layer.  

 

 In the Contents pane (the one on the left side of the screen), right-click on the NE Syrtis 

Basemap layer and click on Properties     . Double-clicking on the layer will also open the 

Properties window. NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 18 

 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 Go to Source and click Set Data Source. 

 

 

 

 

 

 

 

 

 

 Navigate to the Imagery folder in the ExcerciseData folder. (Hint: It’s in Folders under 

Project) Select the NESyrtis_CTX_Basemap.tif file there and click OK, and then click OK 

again.  

 

 

 

 

 

 

 

 

 

 

Now the basemap image displays in the Map. You could also have clicked on the red 

exclamation mark to go directly to selecting a new data source. 

 

 On the Map tab, open the Bookmarks drop-down menu and select Perseverance 

Landing Site. 
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

Notice how this zooms and pans the Map display to a specific location and scale. You can 

create new bookmarks to easily return to specific views of the Map by selecting New 

Bookmark from the Bookmarks drop-down menu and naming it. The current view of the 

Map in the View pane will be saved.  

 

 Under the Map tab, click Full Extent.  

 

 
 

 

 

 

 

This returns the display in the View pane to the entire extent of the Map.  

 

 Explore the Map by using the Explore tool      

to pan by clicking and dragging the mouse in 

the View pane, and Fixed Zoom In/Out 

tools        . After you have finished, click the 

Full Extent button   . 

 

 

You can also zoom in and out using a mouse wheel or the scroll function on a trackpad when 

the Explore tool is selected. You can move sequentially through extents you have viewed 

by clicking on the left and right arrows underneath the Fixed Zoom buttons. 

 

We will be using certain buttons and tools repeatedly, such as Full Extent    . You can 

create shortcuts to any button by right-clicking on the button and selecting Add to Quick 

Access Toolbar. The icon now appears at the very top of the Project window. Remember 

this throughout the workshop if you find yourself using a button frequently.  
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

Step 3: Working with layers 

 In the Catalog pane, on the right side of the screen, expand Maps, double-click on Jezero 

& Nili Topography, and then double-click on Perseverance Landing Site.  

 

 

 

 

 

 

 

 

 

Unlike ArcMap, you don’t need to activate a data frame to view or edit it. What were data 

frames in ArcMap are now individual Maps within a Project. You can have multiple Maps 

within a Project, and they can be open on different tabs in the View pane. 

 

 

 Click on the Jezero & Nili Topography tab at the top of the View pane to display it. 

 In the Contents pane (on the left side of the screen), click and drag the NE Syrtis 

Basemap layer up to just above the Elevation layer. 

 

 

 

 

 

 

 

 

 

The order of the layers in the Contents pane determines what is visible on the Map. Since 

the basemap is not transparent, the Elevation layer underneath is no longer visible.  
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 Click to uncheck the box next to the NE Syrtis Basemap layer to turn it off.  

The Elevation layer is now visible.  

 

 

 

 

 

 

 

 

 

 

 

 

 Move the NE Syrtis Basemap layer back to the bottom and turn it back on. 

 Go to the Jezero & Nili Geology Map in the View pane, right-click on the Geologic Units 

layer, and select Copy. 
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 Now go to the Jezero & Nili Topography Map in the View pane. In the Contents pane, 

under Drawing Order, right-click on the name of the Map and select Paste. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you copy and paste a layer, it will look the same since a layer contains instructions on 

how to display data. It creates a new layer file in the Project that is a copy of the original 

layer file. If you edit how the data is displayed in one Map, such as changing the color, it will 

not affect the appearance of the layer in the Map that it was copied from. However the 

copied layer is using the same data as the original layer. So, if you edit the features in that 

layer in one Map, such as drawing new features, you have edited the source data and those 

changes will appear in all other Maps with layers using the same data. 

 

 Right-click on the Geologic Units layer you just pasted and select Remove     .  

 

Alternatively, you could have clicked Undo at the top of the Project window on the Quick 

Access toolbar or Ctrl-Z until the layer was removed.  
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Step 4: Viewing attribute tables 

The source data for feature classes, and some rasters, can be viewed in their attribute tables.  

 

 Go to the Jezero & Nili Geology Map in the View pane. In the Contents pane, right-click 

on the Geologic Units layer, and select Attribute Table.  

 

You can also open the attribute table by holding down Ctrl and double-clicking on the layer, 

or by clicking once on the layer to select it and then doing Ctrl-T. 

 

 

 

 

 

 

 

 

 

 

 

In this table you can view all the geometric, quantitative, and qualitative properties of the 

features. 
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 Right-click on SHAPE_Area and select Sort Descending.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The feature with the largest area is now at the top of the table.  

 

 Click on the 1 at the start of the largest feature’s row.  

 

This selects the feature. Both the row in the attribute table and the outline of the feature in 

the View pane are highlighted in cyan.  
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 Chapter 1: Project basics  Exercise 1: Getting started in ArcGIS Pro 

 Under the Map tab, in the Selection group, click Clear to un-select the feature. 

 

 

 

 

 

 

The cyan highlighting is gone.  

 

 Close ArcGIS Pro without saving the Project. 

 

ArcGIS Pro does not use the map document format that ArcMap did, with files ending in .mxd. 

Therefore, any changes you make to displaying data in Pro, like you have done in this first 

exercise, will not affect the original map document you imported at the start. However, if you 

make changes to the source data, you will also see those changes if you open that map 

document in ArcMap, since it is displaying the same data. 
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 Chapter 1: Project basics  Chapter Summary 

Chapter Summary 

Now you have seen some of the basic capabilities of ArcGIS Pro, including setting up a 

new Project, the structure of Projects, and how to organize and explore data. Files are 

always found on the right side of the screen in the Catalog pane, and layers are always 

found on the left side of the screen in the Contents pane.  

 

You have also seen how the View pane can be used to open and explore multiple 

elements of a Project, and how data frames within map documents in ArcMap are now 

Maps within a Project in ArcGIS Pro.  

 

Notes:  
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 Chapter 2: Working with rasters 

Chapter 2: Working with rasters 

Introduction 

In this chapter, you will learn the basics of loading, symbolizing, and analyzing raster data. 

Rasters are analogous to image files. A single-band raster contains an array of pixels, called 

cells, each with a position and a single value which could represent brightness, elevation, 

intensity of a quantity, or any other numerical data. A raster could also have multiple bands, 

each having the same array of cells but with cell values for different quantities, such as 

different color bands. A raster basemap is usually the starting point for any Map, and is 

typically an aerial or orbital image, or a mosaic of images. Rasters can be organized into 

datasets within geodatabases, but can also be stored outside of geodatabases. Since rasters 

are typically the most demanding of storage space among GIS files, we have put the images 

provided for this workshop in a single folder, the Imagery folder, outside the geodatabases we 

will be working with. Rasters produced from analyzing these images will be stored within 

individual geodatabases designated for each exercise.  

 

Objectives 

 Load images as rasters in a Map 

 Utilize tools on the Map, Analysis, Imagery, and Raster Layer tabs to investigate and display 

rasters 

 Find locations and take measurements of features in a raster 

 Symbolize rasters, both continuous and discrete 

 Analyze rasters to produce new raster products 

 Convert continuous rasters into discrete rasters 

 Modify labels in preparation for making Layouts 

 

Terms and Tools 

 Basemap 

 Cell Size 

 Favorites 

 Raster 

 Symbology 

 Geoprocessing Tools: Project, Slope, Reclassify, Raster to Polygon 

 Raster Functions: Hillshade, Statistics and Histogram  

 Tab Ribbon Buttons: Symbology, DRA, Swipe, Transparency, Go To XY, Measure, Raster 

Functions, Export Raster, History, Create Chart NO
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Exercise 2A: Loading, exploring, and 

symbolizing rasters 

 

Step 1: Set up a new Project 

 Start ArcGIS Pro, and select Start without a template     . 

 In the Catalog pane, expand Folders     . You can see that the folder connection you made 

to ExcerciseData in the previous exercise no longer appears.  

 

Every time you make a new Project, a new Default geodatabase and Untitled folder are 

created, both designated as the defaults for the Project. Any folder connection or 

geodatabase you added to another Project will not be there unless you add them to your 

Favorites, which we will do now.  

 

 Create a folder connection to the ExerciseData folder (Hint: right-click on Folders).  

 As we did in the previous exercise, make this folder the default     for the Project and 

remove the Untitled folder from the Project.  

 Click the Save Project icon     in the upper left of the Project window on the Quick Access 

toolbar. 

 Navigate to the Chapter2 folder (Hint: look in your Project Folders for the ExerciseData 

folder). Select the Exercise2A folder by clicking on it once. Click Save.  
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 Outside of ArcGIS, Open Windows File Explorer and navigate to the Exercise2A folder. 

You will see that a Project named Exercise2A      has been created there, along with a few 

other default items. 

 Go back to the ArcGIS Pro window. In the Catalog pane, right-click on the ExerciseData 

folder. Notice the option to Add to Favorites  and Add To New Projects     . Select Add 

to New Projects.  

 

Now whenever you start a new Project, a connection to ExerciseData will be automatically 

added, which is very convenient for this workshop.  

 

 Click on Favorites at the top of the Catalog pane. Right-click on the ExcerciseData folder 

and notice the checked option Add to New Projects.  

 

 

 

 

If you uncheck this option, ExerciseData will not be added to your new Projects, but it will 

still appear in your Favorites for easy access to add to a Project. But for this workshop, we 

will want it added to all new Projects.  

 

A geodatabase cannot be renamed when it is the default geodatabase. So, we will create a 

new geodatabase and give it the specific name we want.  

 

 Go back to the Project tab at the top of the Catalog pane.  

 Right-click on Databases and select New File Geodatabase     . Navigate to the 

Excercise2A folder and type Excercise2A as the name. Click Save.  

 

This new geodatabase is automatically added to your Project. 

 

 As you did in the previous exercise, make the Excericse2A geodatabase the default     and 

delete the Default    , as you did in the precious exercise.  

 Save your Project.  
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

Step 2: Load rasters into a new Map 

 In the Catalog pane, in the ExcerciseData folder, expand the Imagery folder. Try to drag

-and-drop the Jezero_HiRISE_CTX_HRCS_Mosaic.tif raster into the View pane. Notice 

that nothing happens. 

 

This does not display the raster because there is no Map to load the raster into.  

 

 Right-Click on Jezero_HiRISE_CTX_HRCS_Mosaic.tif     , go to Add To New     , and 

select Map    . Click OK to build pyramids and calculate statistics.  

 

Pyramids allow for faster display and viewing navigation. They set the display resolution as 

appropriate to the viewing extent, rather than trying to display the full resolution at all 

scales, even when the raster cells are much smaller than your screen pixels. Calculating 

statistics will enable certain options in displaying and analyzing the raster. 

 

 In the Catalog pane, expand Maps      to see the new Map you just created, called Map. 

Right-click on it, select Rename     , type Jezero Crater Delta, and hit Return. 

 

You can also rename a Map by slow-double-clicking on the Map’s name, either here in the 

Catalog pane or in the Contents pane (on the left side of your Project window). Notice that 

the Map name can have spaces in it.    

 

Notice that the coordinates at the bottom of the View pane are in degrees.  

 

 Click on the down arrow to the right of the coordinates to see other display options. 

 

 

 

 

 

 

 

 

 

Notice that they are all latitude-longitude coordinates, and no linear units, such as meters. 

This tells you that the raster is not projected. 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

 In the Contents pane, double-click on the raster layer to open the Layer Properties 

window. Go to Source and expand Spatial Reference.  

 

 

 

 

 

 

 

 

 

 

 

Notice that there is only a geographic coordinate system (GCS), and no projected coordinate 

system (PCS), confirming that this raster is not projected. Step 7 (optional) shows you how 

to add a projected coordinate system (PCS) to a raster. 

 

 Click OK to close the Layer Properties window. 

 In the Contents pane, click once on the raster layer’s name and rename it Jezero 

Basemap, then hit Return. 

 From the Imagery folder in the Catalog pane, drag-and-drop the 

Jezero_HiRISE_CTX_HRCS_DEM.tif into the View pane. Click OK to build pyramids and 

calculate statistics. 

 

Drag-and-drop works now that we have a Map open to add the raster to.  

 

 Rename this raster layer Jezero Elevation. (Hint: When we refer to a “layer”, that’s in the 

Contents pane, not the Catalog pane.) 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

Step 3: Explore raster symbology 

 If not already selected, select the Jezero Elevation layer by clicking on it once. Note that 

selected items in the Contents and Catalog panes are highlighted in blue.  

 Click the Raster Layer tab at the top of the Project window and then click Symbology     .  

 

 

 

 

 

 

You can also right-click on the layer and click Symbology. Instead of opening a separate 

window like in ArcMap, this opens a Symbology pane on the right side of the Project 

window. Also note that Symbology is no longer found in the Layer Properties window like 

it was in ArcMap. 

 

 In the Symbology pane, click the arrow for the Color scheme drop-down menu to see 

different color ramps. 

 

 

 

 

 

 

 

 

 

 

 Check the box Show names. Scroll down to choose Temperature                                .  

 Zoom in to an area that is mostly green until your whole view is green. Then click Full 

Extent   on the Map tab.  
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

 In the bottom half of the Symbology pane, under the Statistics tab, change the Statistics 

from Dataset to DRA, which stands for Dynamic Range Adjustment. Now zoom in again on 

a mostly green area.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This option will automatically adjust the stretch to the current viewing extent. You can also 

activate DRA on the Raster Layer tab.  

 

 Go back to Full Extent    .  

 Check that the Jezero Elevation layer is selected in the Contents pane. On the Raster 

Layer tab, in the Compare group click on Swipe    .  
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 Click and hold anywhere in the View pane and drag the mouse up and down, or left and 

right, depending on where you clicked in the display.  

 

 

 

 

 

 

 

 

 

 

 

 

 On the Raster Layer tab, in the Effects group, set to Transparency     to 60.0%. This can 

be done either by typing 60.0 in the box to the right of Transparency and hitting Return, 

or by clicking the arrow for the drop-down menu and dragging the sliding bar until the text 

box says 60.0% (or something close to it). 

 

Now the basemap layer can be seen under the elevation layer. 
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 In the Contents pane, uncheck the box next to the Jezero Elevation layer to turn it off, and 

select the Jezero Basemap layer.  

 In the Symbology pane, change the Stretch type to Minimum Maximum. Change the 

Gamma value to 0.8.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note how the symbology changes immediately without having to click Apply like in ArcMap. 

Also, having the symbology in a pane, rather than a window on top of the map view like in 

ArcMap, makes it easier to see the effects of changes as you make them.  

 

You can continue to adjust the stretch options to your liking. You can also adjust the 

appearance on the Raster Layer tab, in the Enhancement group, though the brightness and 

contrast there do not change the stretch properties.  

 

 Save your Project     . (Hint: on the Quick Access Toolbar at the top of the window.) 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

Step 4: Locate positions on a raster 

 On the Map tab, in the Navigate group, click on Go To XY    .  

 

 

 

 

 

 In the toolbar that appears at the bottom of the View pane, check that the linear units are set 

to dd (decimal degrees). 

 

 

 

 Enter Long: 77.4509 and Lat: 18.4446, then click Return. 

 

The View pane pans to center the location and a green circle flashes to show it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 On the toolbar at the bottom of the View pane, click Flash     to see this location highlighted 

again. This is the Octavia E. Butler landing site of the Perseverance rover.  

 On the Map tab, click again on Go To XY to close its toolbar. 

 Click Full Extent    . NO
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Step 5: Add a coordinate system to a Map 

 On the Map tab, in the Inquiry group, click on Measure        . 

 

The Measure Distance toolbar appears by default. You can make other types of 

measurements, such as area and angles, by clicking on the down-arrow on the Measure 

button on the Map tab, or by clicking the down arrow next to the Measure icon on the 

toolbar.  

 

 Click the down-arrow next to Geodesic to see the mode options.  

 

 

 

 

 

 

Notice that Planar is greyed out. This is because the raster and therefore the Map we 

loaded it into, has no projected coordinate system (PCS), as we confirmed in an earlier step.  

 

 Click on the down-arrow again to close the mode options. 

 Double-click on the Map name, Jezero Crater Delta, in the Contents pane to open the 

Map Properties window. Select Coordinate Systems.  

 

ArcGIS Pro does have some coordinate systems for the Solar System pre-installed, including 

GCSs for all round bodies and PCSs for the Moon and Mars, and more are being added with 

new version releases. But we’d like to use the same projection that the Map you explored in 

Chapter 1 used.  

 
 Click on Add Coordinate System     , and select Import Coordinate System     .   

 Navigate to the Imagery folder and select NESyrtis_CTX_Basemap.tif, the basemap that 

the Map in Chapter 1 used. Click OK. 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

 Under Custom, click on the star next to MTM_clon77_5E to add it to your favorites. This 

will make it easy to access this system in the future. 

 

 

 

 

 

 

 

 

 

 

 

 

 Click OK. In the Measure Distance toolbar, the mode automatically switches to Planar. 

Units switches to metric. 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

Step 6: Measure features on a raster 

 Zoom in on the large crater on the delta fan (its center is at roughly 77.379E, 18.483N) by 

scrolling with your mouse or trackpad with the cursor centered on the crater.  

 Click once anywhere on the rim of the crater, move the cursor to the opposite rim, and then 

double-click. The Measure Distance window displays the approximate diameter of the 

crater, which should be between 870 m and 910 m. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 In the Measure Distance window, change the measurement type from Planar to 

Geodesic.  

 Make the same measurement again. 

 

Planar mode will calculate a Euclidean distance using the projected coordinate system, which 

assumes the surface is flat. Geodesic takes the curvature of the surface into account. At this 

Map’s scale, the difference is negligible, but at smaller scales (i.e. Maps that show a larger 

area), it becomes more significant.  

 

 Close the Measure Distance window. 

 
You can save this Project if you’d like, but you do not need to in order to move on. NO
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Optional Steps 

Step 7: Project a raster 

Although our Jezero Crater Delta Map has a PCS, the Jezero Basemap source raster does 

not. You may want to give the raster a projection to use in the future. 

 

 Open the Geoprocessing pane by clicking on the tab at the bottom of the right-side pane, 

or if it does not appear among the tabs, open by clicking Tools on the Analysis tab. 

 Search for project and click on Project Raster (Data Management Tools). 

 

 

 

 

 For Input Raster, use the drop-down menu to select Jezero Basemap.  

 For Output Coordinate System, use the drop-down menu to select Current Map. 

 Change the Resampling Technique to Bilinear interpolation. Click Run    . 

 

Many mappers prefer bilinear interpolation as it produces a more smoothed image. 

 

 Go to the Catalog pane, and in the Exercise2A geodatabase, right-click on the new raster. 

From Add To New     , click Map     . 
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

 Double-click on Map      in the Contents pane and select Coordinate Systems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The new Map has the PCS we specified, since a Map's coordinate system is set by the first 

layer added to it. 

 

 Click OK. 

 Close this new Map in the View pane and Remove the Jezero_Basemap_ProjectRaster 

layer from the Jezero Crater Delta Map. 

 

You can save this Project if you’d like to, but you do not need to in order to move on.  
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

Step 8: Visualize terrain without a basemap 

We will now create a simulation of the surface with solar illumination from the east, whereas 

the basemap has solar illumination from roughly west  

 

 Click on Full Extent    . 

 Turn off the Jezero Basemap layer and turn on Jezero Elevation layer.  

 On the Imagery tab, in the Analysis group, click on Raster Functions      . In the Raster 

Functions pane, search for and click on Hillshade     . 

 

 

 

 

 

 For Raster, use the drop-down menu to select Jezero Elevation. Change the Azimuth to 

90, so that solar illumination will be from the east. 

 

 

 

 

 

 

 

 

 

 

 Click on Create new layer.   

 

A new layer appears in the Contents pane and the View pane. However, no new data has 

been created, and so this raster does not exist as a .tif file. If you check the Source in the 

Layer Properties window for the Hillside_Jezero Elevation layer (double-click on the 

layer), you will see that the source is still the DEM file. This layer is a different way to 

display the same data as the Jezero Elevation layer. NO
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 Exercise 2A: Loading, exploring, and symbolizing rasters Chapter 2: Working with rasters 

 Use the tabs at the bottoms of the right side pane to switch to the Symbology pane. Change 

Stretch type to Percent Clip and click Yes to Calculate Statistics. Change Gamma to 1.5.  

 We will now save this layer as a raster. Check that the Hillshade_Jezero Elevation layer is 

selected. On the Data tab, in the Tools group, click on Export Raster      .  

 

 

 

 

 

 

 For Output Raster Dataset, click the Browse      button and navigate to the Imagery 

folder. For Name, type in Jezero_Hillshade_90az.tif. Click Save. 

 

If you do not specify the file extension, you can then select the file format from the Output 

Format drop-down menu.  

 

 For Coordinate System, click on the Spatial Reference button. Expand Favorites and 

click on MTM_clon77_5E. Click OK. At the bottom of the Export Raster pane, click Export.  

 

A new layer is added whose source data is the raster we just created from the hillshade, not 

the DEM.   

 

 Go to Symbology and set the new layer Stretch type to Percent Clip.  

 Right-click on the Hillshade_Jezero Elevation layer and select Remove    . 

 In the Contents pane, rename the hillshade layer Hillshade 90az and move it to between 

the Jezero Elevation and Jezero Basemap layers. Turn the Jezero Basemap layer back on 

and turn off the Jezero Elevation layer.  

 Check that the Hillshade 90az layer is selected, and use the Swipe tool    to compare the 

basemap terrain to the hillshade terrain (Hint: it is on the Raster layer tab). 

 

Notice how shadowed regions in one layer are illuminated in the other, and vice-versa.  

 

You can save this Project if you’d like to, but you do not need to in order to move on.  
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Exercise 2B: Raster analysis 

 

Step 1: Find and use the Slope tool 

 Open the Exercise2B Project in one of these ways (ignore any transformation warnings you 

get): 

1) If ArcGIS Pro is still open, click on the Open Project      button at the top left of the Pro 

window. Navigate to the Excercise2B folder, select the Excercise2B Project, and click 

OK. You can save the Exercise2A Project if you would like to, but you not need to in 

order to move on. 

2) If ArcGIS Pro is not open, start it and click Open another project. Scroll down to 

Favorites and expand it to find the ExcerciseData folder and navigate to the 

Excercise2B folder. Select the Excercise2B Project and click OK.  

3) Open Windows File Explorer. Navigate to the Excercise2B folder and double-click on 

the Exercise2B Project file.  

 

You can have more than one Project open at once. To open one Project without closing the 

other, right-click on the ArcGIS Pro icon in your Windows Taskbar and select ArcGIS Pro. 

You can also go to the Windows Start Menu and in the list of applications, expand the 

ArcGIS folder and single-click on ArcGIS Pro.   

 

 Go to the Analysis tab and click Tools      to open the Geoprocessing pane.  
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 Exercise 2B: Raster analysis  Chapter 2: Working with rasters 

 Type slope and select the Slope (Spatial Analyst Tools). 

 

 

 

 

 

If you do not have the Spatial Analyst Extension, go to the Catalog pane and navigate 

to the Exercise 3A geodatabase. Copy the raster dataset Slope and paste it into the 

Exercise 2B geodatabase. Then, skip the next three steps.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 From the Input raster drop-down menu, select Jezero Elevation.  

 Click on the Output raster name. When you do this, the entire pathway name appears. 

Your curser is at the very end, and there you can use Backspace to change the name of the 

output file to Slope. NO
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 Click Run    .  

 

You will see a progress bar at the bottom of the pane showing that the tool is running, and a 

window will appear in the corner when it is finished. A green checkmark indicates the tool 

ran successfully. In this case, you will see a warning but it can be ignored.  

 

If the tool did not run, an “X” in a red circle will appear and clicking on History in the 

Analysis tab will open a pane where details of the processes can be viewed, including any 

errors that occurred.  

 

The new raster is automatically added as a new layer in the Map.  

 

 Make sure the Slope layer is selected in the Contents pane. Go to the Symbology pane. 

Set Primary Symbology to Stretch, set the Color Scheme to Slope                                     

(hint: click Show names), and make sure the Stretch type is set to Percent Clip.  

 

Step 2: Export the result 

This new raster dataset cannot be accessed outside of ArcGIS Pro because, without having 

specified a location for the output raster, it was put inside the default geodatabase. The file 

must be exported to make it available for sharing and use in other programs. 

 

 Make sure the Slope layer is selected, and on the Data tab click Export Raster     .  

 Click on Settings at the top of the Export Raster pane. Change Resample to Bilinear. 

Click on General on top of the pane. 
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 For Output Raster Dataset, click Browse     and navigate to the Imagery folder. Name 

the file Jezero_Slope.tif and then click Save. 

 

If you do not specify the file extension, you can then select the file format from the Output 

Format drop-down menu.  

 

 For Coordinate System, use the drop-down menu to select Jezero Basemap.  

 

Unlike in the previous exercise, the Jezero Basemap layer is now using the projected 

raster for its source data. Optional step 7 of the previous exercise shows how to do this. 

Some tools and functions do not give you the option of selecting the coordinate system of 

the current Map. Therefore, it is helpful to have at least one layer in your Map use source 

data that has the same projection as the Map. This allows you to easily assign that 

projection when using these tools and functions.  

 

 Click Export. 

 Remove     the layer that was just added from the Map in the Contents pane.   

 

This image can now be accessed through Windows File Explorer and shared for use in other 

Maps and programs.  

 

Step 3: Perform statistics on a raster 

 Click on the Raster Functions tab at the bottom of the right-side pane. If you do not see it 

there, go to the Imagery tab and click on Raster Functions      .  

 

 In the Raster Functions pane, search for statistics and select Statistics and 

Histogram      . Select Slope as the Raster from the drop-down menu.  

 Click Create new layer. 

 On the Data tab, click Create Chart       and select Histogram     .  

 

 

 

 

 NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 49 

 Exercise 2B: Raster analysis  Chapter 2: Working with rasters 

 In the Chart Properties pane on the right, set the Number as Band_1 from the drop-down 

menu.  

 

A histogram of cell value appears as a window in the View pane. Also, a Chart tab has 

appeared on the top ribbon, and a chart associated with the layer has appeared in the 

Contents pane.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 On the top of the histogram window in the View pane, click Export     to see the options for 

exporting the data.  

 Close the Chart Properties pane on the right and the window showing the histogram in the 

View pane. Remove     the Statistics and Histogram_Slope layer from the Map. 
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Step 4: Reclassify a raster 

When the Slope layer first appeared, the Symbology was set to Classified and the raster was 

displayed as discrete. However, the source data was still floating point numbers. To create a 

discrete-valued raster, we must use a tool.  

 

 Select the Slope layer, and go to the Geoprocessing pane. If it is still on the Slope tool, 

click the Back button     at the top left of the pane. 

 Search for and select Reclassify (Spatial Analyst Tools). 

 

 

 

 

If you do not have the Spatial Analyst Extension, go to the Catalog pane and navigate to 

the Exercise 3A geodatabase. Copy the raster dataset SlopeReclass and paste it into the 

Exercise 2B geodatabase. Then, skip the next four steps. 

 Select Slope as the Input raster and below Reclassification, click Classify.  
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 First, set Classes to 3, and then set Method to Manual Interval. In the Upper Value 

column, set the first number to 5, the second number to 15, and leave the third as it is. Click 

OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can also edit the table directly on the Reclassify pane by typing in Start and End 

columns and adding new rows and/or deleting unnecessary ones.  

 

 For the Output raster, name the file SlopeReclass. Click Run.  

 Open the attribute table     of the SlopeReclass layer. (Hint: Ctrl-double-click on the layer, 

or select the layer and do Ctrl-T) 

 

Notice the cells now have only three different values (1, 2, or 3) instead of the floating point 

values they had in the Slope layer ranging 0 to 68.2939.  

 

 

 

 

 

 Close the attribute table. NO
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Step 5: Symbolize a discrete raster 

We will now assign colors to the classified rasters pixel values 1, 2, 3. 

 

 Select the SlopeReclass layer and go to the Symbology pane. 

 In the bottom portion of the Symbology pane, on the Values tab, click on the first colored 

box in the Color column.  

 

 

 

 

 

 

 

 Select Medium Apple     (row 3, column 7, hovering the mouse pointer over a color reveals 

its name). Set the color in the next row to Solar Yellow     (row 3, column 5). Set the color 

for the last column to Mars Red    (row 3, column 2). 

 In the Label column, change the first value to <5, the second value to 5-15, and the third 

value to >15. 

 

 

 

 

 

 

 

 

 

Notice that changing the labels changes what is displayed in the Contents pane. It will not 

change the actual data values, which are 1, 2, or 3. Labels and how things appear in the 

Contents pane will later carry over to elements in Layouts, such as legends.  

 

You can save the Project if you’d like to, but you do not need to in order to move on.  NO
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Optional Steps 

Step 6: Reclassify the elevation raster 

 If you have the Spatial Analyst Extension, repeat steps 4 and 5 to reclassify the DEM 

raster used by the Jezero Elevation layer into two classes, with the boundary between the 

classes as –2525 m. (Hint: You’ll need to change the Method to something other than 

Manual Interval to change the number of classes.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Symbolize the low elevations with green and the high elevations with red, and change the 

labels to indicate the range of elevations represented by each of the pixel values. Turn off the 

Slope and Jezero Elevation layers and make both reclassified layers transparent, setting 

the Slope Reclass layer to 25% and the Elevation Reclass layer to 75%.  

 

In this view, bright green regions are both low elevation and low slope, whereas bright red 

regions are both high elevation and high slope. Adjustments like this to display properties 

can help you do quick by-eye analysis before deciding what tool analysis you would like to do 

next. 
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Step 7: Create a map boundary layer 

It is often useful to have a layer that outlines your Map extent. There is no specific tool for this 

in ArcGIS, but here is a quick way to do it.  

 

 Reclassify the Jezero Basemap raster, setting the number of classes to 1. (It doesn’t 

matter what Method you use.) Name the Output Raster MapExtent.  

 In the Geoprocessing pane, find and open Raster to Polygon (Conversion Tools). 

 

 

 

 

 For Input Raster, select MapExtent. Name the Output polygon features MapBoundary. 

Click Run    . 

 Remove the MapExtent layer from the Map.  

 Go to Symbology for the MapBoundary layer and click on the colored box next to Symbol. 

Click Properties at the top of the pane. From the Color menu, select No color. Click 

Apply.  

 

You now have a layer with a polygon that exactly outlines your Map extent.  

 

You can save this Project if you’d like to, but you do not need to in order to move on.  
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 Chapter Summary Chapter 2: Working with rasters 

Chapter Summary 

In this exercise you have learned how to create a new Project, and some of the basics of 

working with rasters. You have also been introduced to using Geoprocessing Tools and Raster 

Functions to analyze rasters, and how to export the results. You have seen how to change the 

appearance of Map layers in the Contents Pane, which does not affect anything about the 

source data displayed in the Catalog pane, and is only saved within the Project document. In 

addition to making your Map easier to interpret, these changes will carry over to presenting 

your Map in a Layout, making your finished product easy to read and understand.  

 

Notes:  
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 Chapter 3: Working with vector data 

Chapter 3: Working with vector data 

Introduction 

In this chapter you will learn the basics of creating, editing, and analyzing vector data, 

geometric shapes that contain spatial reference data. These objects may be points, lines, or 

polygons. In ArcGIS, vector data is stored in files called feature classes, which cannot be used 

with other GIS platforms. Vector data that can be used in all platforms is stored in files called 

shapefiles. Shapefiles can be imported into ArcGIS as feature classes, and feature classes can 

be exported as shapefiles. Unlike rasters, in which each cell can only store one numerical value, 

feature classes contain geometric information for each feature, such as length and area, and 

can also store other values that can be numerical, text, images, or hyperlinks. Creating feature 

classes to represent objects in rasters, such as craters, valleys, ridges, or geologic regions, 

allows for even more extensive analysis of these objects since so much information can be 

stored without needing to create a new file, as with rasters. We will learn how to create and 

edit feature classes and how to use and manipulate existing vector data.  

Terms and Tools 

 Feature Class 

 Field 

 Selection 

 Shapefile 

 Sketching  

 Snapping 

 Streaming  

 

 

 Construction Tools 

 Geoprocessing Tools: Feature to Polygon, 

Project, Clip, Average Nearest Neighbor, 

Pairwise Buffer 

 Tab Ribbon Buttons: Create, Clear, Delete, 

Discard, Save, Modify, Edit Vertices, 

Reshape, Select by Attributes 

 

Objectives 

 Create a new feature class 

 Sketch and edit features 

 View attribute tables 

 Symbolize features 

 Use selection methods 

 

 Create new features from existing features 

 Create and calculate new attributes 

 Import a shapefile 

 Analyze features 
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Exercise 3A: Creating and sketching 

features

 

Step 1: Create a new feature class 

 Open the Exercise3A Project, found in the Exercise3A folder, within the Chapter3 folder. 

 In the Catalog pane, right-click on the Excercise3A geodatabase and from New    , select 

Feature Dataset     . Name it Geology and set the Coordinate System to Current Map. 

Click Run    . 

 Go back to the Catalog pane and expand the Exercise3A geodatabase to see the new 

Geology feature dataset. Right-click on it, and from New select Feature Class     .  

 Name the feature class GeologicContacts, give it the Alias Geologic Contacts, and set 

the Feature Class Type to Line. Click Finish.   

 

Once a geometry type is set for a feature class, it cannot be changed through any editing 

methods. Feature Datasets can contain feature classes with different geometry types, and 

can therefore be useful for organizing your data. 

 

 Go back to the Catalog pane and expand the 

Geology featuredataset to see the newly created 

GeologicContacts feature class     .  

 

Notice how the feature class is automatically 

added as a layer in the Map with the alias name. 

It is turned on but no features are visible, 

because the feature class has no data. 
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Step 2: Prepare for sketching 

 On the Edit tab, in the Features group, click on Create     .  

 

 

 

 

 

 

 In the Create Features pane, click on Geological Contacts to select it. A set of tools 

appears underneath it. 

 

A preferred sketch method for many planetary mappers is streaming. It best simulates the 

act of sketching by hand. This works well for creating features that are not primarily made 

of straight lines. However, manual dexterity varies from person to person, and we will 

explore a different method later. 

  

 If you do not see the Stream      tool, right-click anywhere in the empty space next to the 

tool icons and click Properties. Go to Tools, scroll down and check the square box for the 

Stream Line Tool. Clicking the circle will make this your default tool. Click OK. The 

Stream tool now appears under Geologic Contacts. 

 

 

 

 

 

 

 

 

 

 

 Click on Stream      to select it as our Sketch tool. 

 

Empty space 
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 Right-click anywhere in the View pane and select Streaming Options     . You can also 

access it by typing O on the keyboard. Set the Stream tolerance to 35 m. Click OK. 

 

The stream tolerance influences approximately how often a vertex will be added as you 

sketch. Spacing will be larger than your tolerance if a portion of the sketch is close to a 

straight line.  

 Look at the map scale in the bottom left of the View pane. Multiply it by 4, and change the 

scale to roughly that value. Example: If my scale is 1:41,915 at Full Extent, then I would 

change my scale to 1:10,000. You can do this by typing 1:10000 in the scale box, or click 

the arrow to see a list of common map scales to choose from.  

 

 

 

This is the recommended way to determine the scale you will sketch at to ensure that 

curved lines will look smooth at the scale you want to publish. When beginning a mapping 

project, you should experiment with the stream tolerance so that lines look roughly smooth 

at the scale you are sketching, but you can still easily see individual vertices.  

 

Step 3: Sketch geologic contacts 

You will now sketch features on your Map. This is not a geology lesson, no prior knowledge of 

geology is needed, and this is just for practice drawing. Look for natural boundaries between 

different terrains and landforms, and sketch along those boundaries. If you want some 

guidance, you can refer back to the figure on page 5 that shows a geologic map. The contacts 

are the boundaries between the different-colored regions. You do not need to draw the same 

contacts as this map, and in the interest of time we recommend your sketching be much less 

detailed than this. Aim for creating 3-5 different regions on your Map.     

 

 On the construction toolbar on the bottom of the View pane, ensure that Streaming         

is selected. If it is not, click the down-arrow and select it.  
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 Pan to what appears to be a geologic boundary where you’d like to sketch a contact. Do not 

zoom since we want to maintain sketching at the scale we set in the previous step. 

 Click once anywhere along that boundary and trace it by moving your mouse. Don’t try to 

draw perfectly, edits can always be made later. Sketch for a little while (no need to 

complete the boundary, you can stop anywhere), and then double-click to finish sketching. 

When you finish, you will briefly see the feature as green vertices along a dashed line, and 

then it switches to a line highlighted in cyan (which means it is selected).  

 On the Edit tab, in the Selection group, click Clear     to unselect the feature you just 

sketched.  

 In the Contents pane, click on the line symbol below the Geologic Contacts layer name. 

Click Properties at the top of the Symbology pane and adjust the Color and Line width 

to your liking in order to see your features clearly, but don’t choose something close to 

cyan, as this color is used for noting selected features. You will need to click Apply after 

each change to see the results in the View pane.   

 Read through the following tips, and practice them a bit before you start sketching your 

boundaries. Your goal is to create closed regions, so your contacts should all connect with 

each other or the edge of the Map Boundary. However, set a timer for yourself when you 

begin sketching your contacts (after practicing for a bit) and don’t spend more than 15 

minutes sketching. You do not need to finish in order to move on.  

• Deleting features: Clicking Delete      on the Edit tab will permanently delete all 

selected (cyan highlighted) features. Clicking Discard      on the Edit tab will 

permanently delete any features you’ve sketched since you started sketching or since 

your last Save. Clicking Cancel      on the construction toolbar at the bottom of the 

View pane will permanently delete a feature you are in the middle of sketching. 

 

 

 

 

 

 

• Saving features: Features are not saved when you finish a sketch by double-clicking 

on the Map or clicking Finish      on the construction toolbar. You must click Save     

on the Edit tab. However, once you Save, you can no longer Undo any previous 

edits. Saving a Project does not save edits to features, unless you have set that as a 

Project option. (Options are found by clicking on the Project tab). If you try to close 

a Project, you will get a warning message if there are unsaved edits. 

Finish 

Cancel 
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• Undo: Clicking Undo      on the Quick Access Toolbar, or Ctrl-Z, will remove the last 

feature you finished. If you are in the process of sketching, it will not affect that 

feature but will undo the previous action. You can restore that action by clicking  

Redo     on the Quick Access Toolbar, or Ctrl-Y, unless you have clicked Save     or 

Discard      after your last Undo. 

• Panning while sketching: If you are sketching and nearing the edge of your viewing 

extent, you can hold down C on the keyboard to pause sketching and instantly switch 

to the Explore tool (your cursor will turn into the hand symbol for this tool), which 

lets you pan with the mouse. Holding down C to temporarily access the Explore tool 

works regardless of what you are doing in ArcGIS. Begin by clicking once to pause 

sketching. Then hold down C and click and drag to pan. Release C and move the 

cursor close to where you left off. Click once to continue sketching the feature.  

• Continuing a feature: If you finished a feature and then want to add to it, click 

Modify        on the Edit tab. In the Modify Features pane, under Reshape, select 

Continue Feature       . Click on the feature you want to continue sketching. The red 

vertex shows where you finished sketching. If you want to continue sketching at the 

other end, right-click on the feature and select Reverse Direction     . Position your 

mouse close to the red vertex and click once to start sketching again. Note that you 

may have to set the tool back to Streaming       on the construction toolbar, as it 

usually defaults to the Line        tool even if you have set Streaming      as your 

default tool.  

• Snapping: Snapping will help you connect features to other features by jumping your 

cursor to an element of another feature, such as a vertex or edge, when you get 

within a certain distance of it. This can be very helpful if you don’t want to have gaps 

and overlaps in your sketching, but it can also make things difficult if you’re trying to 

sketch close to another feature but don’t want to actually connect to it. Click on the 

down arrow below the Snapping      button on the Edit tab to see a toggle for turning 

it on and off, options for various types of snapping that can be individually turned on 

and off, and Snapping Settings where you can adjust how close you need to be to a 

feature for it to snap to it. You can also hold down the space bar to temporarily 

suspend snapping while you are sketching.  
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Alternative Method: Sketching without using streaming  

Some people prefer sketching using the Line tool, which some call the “clicky-clicky method.” 

With this tool selected, you can click once to start sketching, and then click once to place 

vertices as you move your mouse. Between clicks, straight lines are sketched. Double-clicking 

finishes the sketch. All the above tips also work with this method.  

 

 Now set your 15-minute timer, and begin sketching your contacts! Don’t forget to Save 

often. 

 When you’re finished sketching, click Save on the Edit tab and Save your Project. 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 65 

 Exercise 3B: Editing and finalizing features Chapter 3: Working with vector data 

Exercise 3B: Editing and finalizing features 

 

 

Step 1: Edit features 

 Open the Exercise3B Project. In the Catalog pane, navigate to the Geology feature 

dataset in the Exercise3A geodatabase (Hint: look for it in Folders). Right click on your 

GeologicContacts feature class and select Copy. Navigate to the Exercise3B 

geodatabase, right-click on the Geology feature dataset, and select Paste.  

 Click the Explore tool      on the Map tab, then pan and zoom to examine your geologic 

contacts features. Locate places you’d like to edit, such as a contact that needs to be 

adjusted to better align with the terrain, or an intersection of contacts that is messy or 

incomplete.  

 Choose one of these locations to start with. Pan to it and zoom to your sketching map 

scale (4 times your full extent scale).  

 Read through the following tips, try each of them out (you can Undo changes while you’re 

practicing), and then edit your contacts. Remember to adjust and turn on/off snapping if 

needed. Clicking Finish commits your changes to the feature but you still need to click 

Save to commit the changes to the data file. Set a timer for yourself when you begin 

making your edits (after practicing for a bit), and don’t spend more than 10 minutes 

editing. You do not need to finish in order to move on.   

• Moving Vertices: Click the Edit Vertices      button on the Edit tab. Click on the 

feature you’d like to edit to select it. This opens the Edit Vertices toolbar at the 

bottom of the View pane. You can now click and drag a vertex. You can also use the 

Lasso      tool on the toolbar to select multiple vertices and drag them all at once.  

• Adding Vertices: On the Edit Vertices toolbar, click Add     . Click anywhere on 

the feature to place a new vertex.  

• Deleting Vertices: On the Edit Vertices toolbar, click Delete      . Click on a 

vertex to delete it. To delete multiple vertices at once, click and drag to lasso the 

vertices. When you release your mouse click, the vertices will be deleted. 

• There is also a button on the Edit Vertices toolbar for Continue Feature     ,         

which you probably used in the previous step. 
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• Redrawing Segments: Click on Reshape on the Edit tab. Select Streaming or 

Line on the toolbar at the bottom of the View pane, depending on which sketching 

method you prefer. Click once on the feature where you want to start redrawing. 

Sketch the new segment until you connect with the feature again. Double-click to 

finish redrawing. 

 

 While making edits, remember to click Save on the Edit tab. 

 

If this was an actual mapping project, then once you completed your geologic contacts, 

you would use the geoprocessing tool Union to combine them with a line feature class 

version of your Map boundary to create closed shapes along the edge of your Map.  

 

Step 2: Build polygons of geologic regions 

Now you will use a sample of a completed geologic contacts line feature class to create a 

geologic units polygon feature class. 

 

 In the Catalog pane, go to the JezeroNili geodatabase in the Chapter1 folder and 

expand it. Copy the GeoContacts_Complete feature class and Paste it into the Geology 

feature dataset in the Exercise3B geodatabase.  

 Add the GeoContacts_Complete feature class to the Map by dragging and dropping it 

into the View pane. Turn off your Geologic Contacts layer and click Full Extent.  

 Open the Feature To Polygon (Data Management Tools) geoprocessing tool. For 

Input Features, use the drop-down menu to select GeoContacts_Complete. Name the 

Output Feature Class GeologicUnits. Click Run.  

 

 

 

 

 

 

Now we must create an attribute to uniquely identify each unit for symbology and labeling. 
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 Open the attribute table for the GeologicUnits layer. Click Add    .  

 

 

 

 

 

 

 

 

 

 Name the new field Unit and set the Data Type to Text.  

 

 

 

 

 

 

 

 

 Click Save     on the Fields tab and close the Fields window by clicking on the X on its tab 

in the View pane.  

 

 

 

 

 

 

You would normally now type the names of each unit into the attribute table, but for brevity 

we will quickly give them unique identifiers.  
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 In the attribute table, click on Unit and click Calculate      on the Field toolbar on the top 

of the attribute table.  

 

 

 

 

 

 

 

 

 

 

 

 Click on the text box under Unit and double-click OBJECTID in the Fields box above. 

Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now there is a column in the attribute table with numerical placeholders for where you 

would later type in descriptive names of different geologic units.  
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 Close the attribute table and go to the GeologicUnits layer’s Symbology. For Primary 

symbology select Unique Values. For Field 1, select Unit.  

 

This exercise has led you through the basic process of creating geologic units, or any 

polygon feature class. Although your end goal is a polygon feature class, you should not 

start by creating a polygon feature class. Trying to sketch adjacent polygons is difficult. It 

will produce topology problems (overlaps or gaps) and are extremely difficult to edit since 

to change one polygon you also have to change all of its adjacent polygons. The procedure 

we just led you though eliminates these issues by drawing single lines for the boundaries 

and then building the polygons based on these. You should never edit the polygons you 

create through this process. If after you’ve made them you want to edit something, go back 

to the line feature class and edit the boundaries, then re-build the polygons.  

 

There is a wonderful product provided by the USGS called the PGM Toolbox. It streamlines 

this process of creating geologic maps. It will check your contacts feature class for topology 

errors (gaps, overlaps, etc.), guide you through fixing them, and then build the polygons. It 

also has all the standard symbologies used in geologic maps built into it. You can download 

the PGM toolbox here: https://doi.org/10.5066/P91ZHZGH.  

 

You can save this Project if you’d like to, but you do not need to in order to move on.  
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Exercise 3C: Importing shapefiles and using 

selection  

 

Step 1: Import a shapefile as a feature class 

 Open the Exercise3C Project. 

 In the Catalog pane, locate the CraterData folder in the ExcerciseData folder and expand 

it to find the Jezero_CraterDatabase.shp shapefile.  

 

Since this is a shapefile (not ArcGIS specific) it cannot be simply copied and pasted into a 

geodatabase. It will need to be converted into a feature class. You can still add shapefiles to 

the Map, but feature classes offer more attribute capabilities. Also, some ArcGIS processing 

and analysis functions cannot be used on shapefiles.  

 

 Right-click on the Excercise3C geodatabase and from Import select Feature Class(es). 

 For Input Features, browse to the CraterData folder and select the shapefile. Click OK. 

Click Run. 

 Go to the Catalog pane, find the Jezero_CraterDatabase feature class in the 

Excercise3C geodatabase. If you do not see it there, right-click on the geodatabase and 

select Refresh    . Add it to the Map.  

 

Step 2: Project the new feature class 

ArcGIS has projected the new layer “on the fly” based on the coordinate system of the Map, but 

the Jezero_CraterDatabase feature class has no projection of its own. To perform spatial 

analysis we need to project it. 

 

 Go to the Geoprocessing pane and open the Project (Data Management Tools) tool. 
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 For Input Dataset or Feature Class, choose Jezero_CraterDatabase. For Output 

Dataset or Feature Class, leave it as the default name. For the Output Coordinate 

System, use the drop-down menu to select Current Map [Jezero Crater Delta]. Click 

Run. 

 Right-click on the Jezero_CraterDatabase layer in the Contents pane and select 

Remove.  

 

Step 3: Clip the feature class to the Map extent 

 Right-click on the Jezero_CraterDatabas_Project layer in the Contents pane and select 

Zoom To Layer     . 

 

The Jezero_CraterDatabas_Project feature class covers a larger area than our Map. So 

we will delete data outside of our Map’s extent. 

 

 Find and open the Clip (Analysis Tools) geoprocessing tool. For Input Features or 

Dataset, select Jezero_CraterDatabas_Project. For Clip Features, select Map 

Boundary. Name the Output Features or Dataset CraterCenters. Click Run.  

 

 

 

 

 

 Remove the Jezero_CraterDatabas_Project layer from the Map. Go to Full Extent    .  

 For the CraterCenters layer’s Symbology, click on the point symbol (either in the 

Contents or Symbology panes) and click on Properties at the top of the Symbology 

pane. Change the Color to Ginger Pink    (row 3, column 12), the Outline color to Arctic 

White     (row 1, column 1), decrease the Outline width to 0.5 and increase the Size to 6. 

Click Apply. 
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Step 4: Select features by attribute values to highlight smaller 

craters  

 On the Map tab, in the Selection group, click Select by Attributes        . 

 For Input Rows select CraterCenters. For Selection Type, keep the default New 

Selection, but open the drop down menu to see the other choices. 

 

We want to select only the craters with diameters smaller than 50 m. 

 

 For Where, use the drop-down menu to select the DiamM field. In the box that appears to 

the right that says is equal, use the drop-down menu to select is less than. In that last 

box, type 50.0. 

 

 

 

 

 Click Apply to see the selected craters highlighted in cyan in the View pane. You may have 

to move the Select By Attributes window out of the way. Click OK.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 73 

 Exercise 3C: Importing shapefiles and using selection Chapter 3: Working with vector data 

Step 5: View selected features in the attribute table 

 Open the attribute table for the CraterCenters layer. You should see a few rows highlighted 

in cyan.  

 At the bottom of the attribute window, click Show Selected Records. Scroll down to see 

that only selected features are shown in the table now. At the bottom of the window, notice 

how 153 craters have been selected from a total of 235. 

 

 

 

 

 

 

 Close the attribute window. 

 

Step 6: Create a new layer from selected features 

 Right-click on the CraterCenters layer, and from Selection click Make Layer From 

Selected Features. A new layer appears just above the original layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show Selected Records 

NO
T 

FO
R 

DI
ST

RI
BU

TI
ON

spif@
astro.cornell.edu



 74 

 Exercise 3C: Importing shapefiles and using selection Chapter 3: Working with vector data 

 On the Map tab, in the Selection group, click Clear    . 

 

Clear is another button you will likely use a lot, so you may want to add it to your Quick 

Access Toolbar at the top of your Pro window. (Hint: Right-click on the Clear button.) 

 

 Turn off the CraterCenters layer.  

 

The new layer only displays craters less than 50 m in diameter. However, if you open its 

Layer Properties window and check the Source, it is still getting its data from the 

CraterCenters feature class, which has all the craters in it.  

 

Step 7: Create a new feature class from a selection layer 

Look in the Catalog pane and notice that CraterCenters selection does not appear as a new 

feature class in the Exercise3C geodatabase. It is only a layer in the Map and a way to display 

the CraterCenters features. It will be saved as a part of your Project, but does not exist as a 

file you can share with others. 

 

 Right-click on the CraterCenters selection layer and from Data select Export 

Features     .  

 

 

 

 

 

 

 

 

 

 

 

 

Note that if there are currently selected features in the layer, only the selected ones will be 

exported. NO
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 Name the Output Feature Class CraterCenters_small. Click OK.  

 

Notice in the Catalog pane there is now a new feature class named CraterCenters_small. 

  

 Go to Symbology for the CraterCenters_small layer. Change the color to Electron Gold    

 (row 3, column 4) and decrease Size to 4. Click Apply. 

 Remove the CraterCenters selection layer from the Map and turn the CraterCenters layer 

back on.  

 

Step 8: Analyze crater size distribution 

 Open the Average Nearest Neighbor (Spatial Statistics Tools) geoprocessing tool. 

 

 

 

 

 

 For Input Feature Class, select CraterCenters. Check the box next to Generate Report, 

and then click Run. 

 In the details window that appears to the right, click the link for Report File.  

 

An html file opens showing the results of the analysis. It has been saved to the folder you are 

currently working in. It will not show up in the Catalog pane, but you can go to Windows File 

Explorer to see it in the Exercise3C folder. 

 

 Close the browser window with the analysis results in it.  

 

You can save this Project if you’d like to, but you do not need to in order to move on.  
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Optional Steps 

Step 9: Calculate circumference and area for the crater points 

 Open the attribute table of the CraterCenters layer.  

 As in the demo, create a new field titled AreaM2 and calculate the area of the craters using 

the diameter. You can find the code for π in the Helpers box. Scroll down to find math.pi 

and double-click on it to add it to your expression.  

 Close the attribute table.  

 

Step 10: Buffer the crater points to create approximate polygon 

features 

 Open the Pairwise Buffer (Analysis Tools) geoprocessing tool.  

 

 

 

 

 For Input Features choose CraterCenters. For Output Feature Class, name the file 

CraterPolygons. 

 For Distance [value or field], use the drop-down menu to the right to select Field. From 

the drop-down menu below that, select Radius (meters). Click Run.  
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 Turn off the CraterCenters and CraterCenters_small layers. Symbolize the new polygon 

layer with no fill color and a Medium Apple     (row 3, column 7) outline with width 1.5. 

 If Outline color is greyed out, click on Structure    . Click Add symbol layer and select 

Stroke layer. Then, click on Symbol      to go back to Appearance.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Pan and zoom to explore these circular approximations of the craters. Use the Swipe     tool 

to compare the features to the basemap.   

 Open the attribute table for the CraterPolygons layer to compare the Shape_Area values 

to the AreaM2 values. The values should match.  

 

You can save this Project if you’d like to, but you do not need to in order to move on. 
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Chapter Summary 

In this chapter you have learned the basics of creating, editing, symbolizing, and analyzing 

vector data. Our end product is a variety of feature classes representing geologic features in 

and around the Jezero Crater delta that can now be used for further analysis. You have also 

seen how attribute tables show you geometric and ancillary information of vector data and 

how to manipulate those tables.  

If you were doing initial investigations for potential research, existing vector data is a good 

place to start. However, if you are ready to perform your own analysis for a research project, 

you should consider making your own data from scratch using the methods in this chapter. It 

is time-consuming, but it will ensure that the aspects of the data most important to your 

research are included, and you will be using spatial references that are possibly more up-to-

date than those in pre-existing datasets. Though many processes in ArcGIS can be automated 

for performing large numbers of repeated operations, either through Model Builder or writing a 

Python script, things like sketching features generally needs to be done by hand. If you’ve 

invested a lot of time into a dataset, you should consider sharing it with others in your 

research group or even in an online forum like ArcGIS Online, so that others can use your data 

for their initial investigations and as guidance for doing their own research. 

 

Notes:  
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analysis 

Exercise 4A: Converting rasters to 

vector data 

 

Exercise 4B: Using overlay to find 

landing site areas 
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 Chapter 4: Criteria Analysis 

Chapter 4: Criteria analysis 

Introduction 

In this chapter you will learn how to prepare data for analysis that involves finding candidate 

objects, locations, or regions that meet certain criteria through a process of selection and 

combination. You will be using analysis techniques on vector data, including proximity and 

overlay analysis, to determine potential touchdown locations for the Mars2020 Perseverance 

rover. The criteria we will use could have hypothetically been programmed into the self-guided 

landing system, and then our map could have helped refine those criteria by predicting where 

the rover would touchdown under those requirements. Our criteria are that the rover must land 

in an area that: 

1) Is below –2525 m in elevation, to ensure the rover lands on the crater floor; 

2) Has slopes that are less than 5 degrees, to minimize stresses due to some wheels 

touching down before others; 

3) Be within the determined landing ellipse, which is centered roughly on the ideal 

touchdown location and ensures we land within a certain distance from the delta; 

4) Be able to contain a 25-m-radius error circle to account for the margin of error in the 

self-guided landing system; 

 

Objectives 

 Convert raster data into vector data 

 Perform overlay analysis using Union and Intersect 

 Perform proximity analysis using Buffer 

 Manage polygon features 

 

Terms and Tools 

 Dissolve 

 Overlay 

 Geoprocessing Tools: Union, Pairwise Buffer, Intersect 
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Chapter 4: Criteria Analysis Exercise 4A: Converting Rasters to Vector Data 

Exercise 4A: Converting Rasters to Vector Data 

 

Step 1: Convert a discrete raster into a polygon feature class 

 Open the Exercise4A Project. 

 Create a new Feature Dataset   in the Exercise4A geodatabase, name it 

LandingSiteAnalysis, and set the coordinate system to the current Map. 

 Open Raster to Polygon (Conversion Tools).  

 

 

 

 

 

 For Input Raster, select SlopeReclass (it’s inside the Slope & Elevation layer group). 

For Output polygon features, browse     to the LandingSiteAnalysis feature dataset and 

name the feature class Slopes, and click Save. Click Run. 

 In the Contents pane, turn off the Slope & Elevation Rasters layer group and collapse it 

by clicking the arrow to the left.  

 

Step 2: Symbolize the polygon feature class 

 Open the Symbology pane for the Slopes layer.  

 From the drop-down menu under Primary symbology, select Unique Values      . For 

Field 1, select gridcode.  

 Change the color of the classes to bright green   , yellow    , and red    , similar to the 

reclassified raster. (Hint: Click on the colored rectangles under the Classes tab. The colors 

do not have to be exactly the same ones that you used before.)
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Chapter 4: Criteria Analysis Exercise 4A: Converting Rasters to Vector Data 

Now we will change the labels for each class to match those of the SlopeReclass layer.  

 

 On the Classes tab in the Symbology pane, in the Label column, double click on each 

value to change it. Look in the Contents pane at the SlopeReclass layer, within the Slope 

& Elevation layer group, to see the labels.  

 

 

 

 

 

 

 

 

 

 Click on More in the upper right corner of the Classes tab and select Format all symbols. 

Set the Outline color to No color. Click the back arrow at the top left corner of the 

Symbology pane.  

 

 

 

 

 

 

 

 

 

 Click on More again, and uncheck Show all other values. The Raster to Polygon tool 

automatically adds symbology to values other than those in the original raster. This is where 

any raster cells that have no data would be accounted for. No such cells exist in our raster, 

so this symbology is unnecessary.  

 Set the transparency     of the Slopes layer to 50%.  
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Chapter 4: Criteria Analysis Exercise 4A: Converting Rasters to Vector Data 

Optional: Convert the elevation raster 

 Repeat the previous steps for the elevation raster, name the output feature class 

Elevation, symbolize it (colors and labels), and set the transparency to 75%.  

 

You can save this Project if you’d like to, but you do not need to in order to move on. 
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

Exercise 4B: Using overlay to find landing site 

areas 

 

Step 1: Merge feature classes using Union 

 Open the Exercise4B Project.  

 Open Union (Analysis Tools). 

 

 

 

 

 For Input Features, first select Elevation, and then select Slopes. For Output Feature 

Class, name the feature class ElevationSlopesUnion. Click Run. 

 Open the attribute table for the ElevationSlopesUnion layer.  

 

There are now more polygons than in either of the original feature classes, subdivided by 

their combination of attributes from both layers. There are six different combinations of 

attributes from the input features (3 possible attributes for slope and 2 for elevation), and 

each different region of overlap has become its own polygon. We now want to symbolize the 

layer to see these six different attribute combinations. 

 

 

 

 

 

 

 

 

 

 

 Set the transparency of the new layer to 0%. NO
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

 In the Symbology pane, check that Primary Symbology is set to Unique Values and 

Field 1 is set to gridcode (make these changes if necessary). 

 

The first gridcode value is coming from Elevation attribute. The second gridcode value is 

coming from the Slope attribute, since that is the order in which you entered them in the 

Union tool. That is why you are not seeing all the polygons with six different colors in the 

View pane. 

 

 Underneath Field 1, click on Add field. Open the drop-down menu for Field 2. 

 

You don’t see another gridcode option listed because the alias for both is gridcode. If you 

hover the mouse over the name of the second gridcode column in the attribute table, you’ll 

see that the actual name of the field is gridcode_1. We need to change the alias to be a 

unique name.   

 

 On the Table tab, in the Field group, click on Fields       to open the field editing window in 

the View pane. The name of this window on its tab is Fields: ElevationSlopesUnion. 

 In the Field Name column, find gridcode and change its Alias to Elevation. In the Field 

Name column, find gridcode_1 and change its Alias to Slope. Click Save     (top ribbon, 

on the Fields tab in the Manage Edits group) and close the field editing window.  

 Go back to the Symbology pane. For Field 2, select Slope, which now appears on the drop

-down menu.  

 

Now there are six colors symbolizing the different combinations of elevation and slope 

classifications.  

 

Note: If you see more than six colors, it is likely because one or both gridcode values has an 

additional “0” value that was added in the Union, which is an artifact of the edges along the 

map extent not lining up perfectly. You can find and delete these few polygons in the 

attribute table if you like, though it is not necessary for this exercise. If you do delete these 

polygons, go back to the Symbology pane and click on More in the Classes tab. Select 

Refresh count. If this does not work, switch Primary Symbology to Single Symbol, then 

back to Unique Values. Redefine the fields again.  

 

 Close the attribute table. 
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

Step 2: Select potential landing areas 

 On the Map tab, click on Select By Attributes       . 

 

We want to select the lowest classes for both elevation and slope, which in both cases 

corresponds to gridcode values of 1.  

 

 Select ElevationSlopesUnion layer and build the following query: Slope is equal to 1 and 

Elevation is equal to 1. 

 

 

 

 

 Click OK. 

 Open the attribute table for the ElevationSlopesUnion layer to see which polygons are 

selected, and how many have been selected (it should be 3,870 out of 97,004). If you do 

not see any selected polygons, you can scroll down a bit. If you still don’t see any, you can 

try either reordering the table so that both Slope and Elevation are sorted by ascending 

(Hint: right click on the Field name), or click Show selected records at the bottom of the 

table.  

 

 

 

 

 

 

 

 

 

 

You should also see the selected regions highlighted in the View pane. 

 

 Close the attribute table. NO
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

Step 3: Create a feature class from the layer selection 

We want to create a new feature class with only these selected features.  

 

 Right click on the ElevationSlopesUnion layer, and from Data choose Export 

Features      .      

 For Output Feature Class, name the file ElevationSlopeSafe. 

 Click on the Environments tab at the top of the Export Features window. Set the Output 

Coordinate System as Current Map [Jezero Crater Delta] and click OK to see the new 

layer appear. 

 Clear the selection and turn off the ElevationSlopesUnion layer.  

 

Step 4: Symbolize and explore the results 

 Go to the Symbology pane for the ElevationSlopeSafe layer. On the Classes tab, click on 

the colored box under the Symbol column.  

 On the Gallery tab, type overlay in the search box and hit return, and click to select Key 

Terrain.  
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

 Set the layer’s transparency to 50% on the Feature Layer tab. 

 Explore and zoom around to notice how the ElevationSlopeSafe features overlap the 

greenest areas where both the elevation and slopes are low.  

 

 

 

 

 

 

 

 

 

Step 5: Buffer the safety region to account for navigation errors 

The landing system is programmed to avoid landing anywhere within 25 m of an area that does 

not meet the safety requirements we have established in the previous steps. We will apply a 

negative buffer to eliminate these areas. We don’t need this resulting region to be covered by 

multiple feature classes, so we will also use this tool to combine all the polygons into one.  

 

 Turn off the Slopes and Elevation layers. 

 In the Geoprocessing pane, find and open Pairwise Buffer (Analysis Tools). 

 

 

 

 

 

 

 For Input Features, choose ElevationSlopeSafe. For Output Feature Class, name the 

file PotentialLandingSafe. For Distance, ensure that Linear Unit is selected. NO
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

 Select Meters below Linear Unit and enter –25 in the box to the left of that. 

 Set Dissolve Type to Dissolve all output features into a single feature. Click Run. 

 Open the attribute table for PotentialLandingSafe.  

 

Notice there is now only 1 feature. 

 

 

 

 

 

 

 

 Close the attribute table. With the PotentialLandingSafe layer selected in the Contents 

pane, Zoom in and use Swipe on the Feature Layer tab to compare the buffered layer 

to the ElevationSlopeSafe layer. Turn off the ElevationSlopeSafe layer. 

 Symbolize the PotentialLandingSafe layer as you like or leave it as is. 

 

Step 6: Eliminate areas outside of the landing ellipse 

 In the Catalog pane, navigate to the JezeroNili geodatabase      in the Chapter1 folder, 

and in the MappingData dataset    find the LandingEllipse feature class     . Drag and 

drop it into the View pane to add it to the Map.  

 In the Geoprocessing pane, find and open Intersect (Analysis Tools). Select the 

LandingEllipse and PotentialLandingSafe layers for Input Features. Name the 

Output Feature Class PotentialLandingAreas. Click Run. Turn off the LandingEllipse 

and PotentialLandingSafe layers. 

 Symbolize the new layer as you like.    
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Chapter 4: Criteria Analysis Exercise 4B: Using overlay to find landing site areas 

Step 7: Compare to the actual landing site 

 In the same dataset as the LandingEllipse feature class, find the LandingSite feature 

class      and add it to the Map. This is the actual touchdown site of the Perseverance rover.  

Does the Octavia E. Butler Landing Site fall within the region you derived in the workshop? 

(Hint: symbolize the LandingSite point to make it easier to see.) How do you think the 

data you produced in this workshop could have been used in mission planning prior to 

landing? 
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Chapter 4: Criteria Analysis Chapter Summary 

Chapter Summary 

In this chapter you learned how to combine raster and vector data to perform analysis based 

on specific criteria. You converted rasters into feature classes so that you could use vector 

analysis tools. It is also possible to convert vectors into rasters and use raster analysis tools, 

though this usually only works well with two-dimensional vectors like polygon feature classes. 

Raster Calculator is a general overlay tool that is used to combine data from multiple rasters. 

It is best to carefully plan out the steps you will take to perform your analysis ahead of time, 

since there are usually multiple ways to obtain the same results and you must decide which is 

most efficient for your purposes. For instance, we could have created new layers through 

selection for each of the elevation and slope layers that would only contain the lowest ranges, 

and then used the Intersect tool to create polygons that fit both requirements. Instead, we 

first used Union and then a single selection from the resulting layer, which for this exercise was 

quicker and easier. 

For an analysis process that you plan on repeating, the Model Builder function can be used to 

create a pipeline of tools and outputs to essentially create a new tool that you design. This 

model can then be saved as a single tool. If you are working with only rasters, you can use the 

Processing Templates tool on the Data tab to create a single function out of a series of 

functions. 

 

Notes:  
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Appendix 
Common File Types 

 

Main Components of the ArcGIS Pro 

Window 

 

Ribbons 

 

Glossary NO
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Common File Types 
Feature Class:  

 Similar to shapefile, but with additional files for use in ArcGIS 

 Can ONLY be used within an ArcGIS geodatabase, can be exported as a shapefile, can 

be exported as a shapefile 

Feature Dataset:  

 Contains multiple feature classes related by content, must have the same coordinate 

system 

Geodatabase: *gdb  (default geodatabase: ) 

 ArcGIS file structure for storing, organizing, and sharing data with other ArcGIS users 

Image Files: *tif  

 Common: TIFF (regular or GeoTIFF), JPEG, JPG2, PNG, BMP, GIF, etc. 

 Dataset specific: SAR, SRTM, DEM, DOQ, LAS, many more  

Layer: *.lyrx 

 Stores information for how to display a particular data source or dataset 

 Does NOT store any source data 

Map Document: *.mapx  

 Stores information for how to display all data in a map 

 Does NOT store any source data 

Project: *.aprx 

 Stores information for how to display and organize all ArcGIS data, including Maps, 

Local and Global Scenes, Tables, and links to Folders and Geodatabases 

 Does NOT store any source data 

Packages:*.lpkx     , *.mpkx      , *.ppkx  

 The tools for creating Packages are located on the Share tab 

 Stores both display instructions and source data 

 Good for sharing with other ArcGIS users who do not have access to your 

geodatabase 

Shapefile: *.shp  

 Stores spatial and geometric data for features 

 Used by most GIS software , can be used in ArcGIS but not within a geodatabase, can 

be imported as a feature class or exported from a feature class 

Table:  

 Tabular data, can be imported from other formats like MS Excel and then added to 

the attribute table of a feature class, or can be exported from the attribute table data 

of a feature class NO
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Main components of the ArcGIS Pro window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. Adaptive Tabs that change depending on what type of data you are viewing or have selected. 

 Tab Ribbon and Tool Groups appear with relevant tools for each of the tabs. There are no longer 

toolbars that need to be opened individually. 

 The View Pane is the main workspace where you can view elements of your project, such as Maps, 

Tables, Local and Global Scenes, and Layouts. 

. A Map displayed within the View Pane. 

. This shows the map scale. You can change it from the drop-down menu next to it or by typing 

the scale you want. 

This shows the position of the cursor in the coordinates of the map. You can change the units 

shown here by clicking on the drop-down menu to its right and selecting your desired units.  

. An Attribute Table displayed within the View Pane that shows data associated with a Map 

layer. 

 The Contents Pane contains a list of all the layers in the Map. 

The Catalog Pane is where you manage, organize, and access your geographical data and Project 

elements. 

A layer is a displayed set of geographic features with the same type of geometry (point, line, 

polygon) or a raster (image). 
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 Quick Access Toolbar (can add any buttons to customize)

 Map Ribbon

 Insert Ribbon

 Analysis Ribbon

Ribbons 

New Project 

Open Project 

Save Project 

Undo & Redo 

Add New Geodatabase 

Connection 

Add New Folder Connection Add New Item 

Fixed Zoom 

In & Out Explore 

Full Extent 
Go to XY 

Select Select by 

Attributes 

Open Attribute 

Table 

Clear Selection 

Measure 

Geoprocessing 

Tools Raster 

Functions 

Commonly Used Tools 
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 View Ribbon 

 

 

 

 

 

 

 

 

 Edit Ribbon 

 

 

 

 

 

 

 

 

 Imagery Ribbon 

 

 

 

 

 

 

 

 

 Share Ribbon 

 

 

Open Catalog Pane Open Geoprocessing Pane 

Open Contents Pane 

Open Raster 

Functions Pane 

Create Packages 

Print Map 

Export Map 

Selection Tools  

Open Attribute Table Snapping Options 

Commonly Used 

Editing Tools 
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Glossary 

Attribute Table: A table that displays non-spatial information about features in a feature class, 

such as feature ID numbers, length, and area. More columns, called fields, can be added to 

associate additional data with features. Some rasters can also have attribute tables that display 

frequency values for each cell value, but the Statistics and Histogram raster function must be 

performed in order to create this table. 

Average Nearest Neighbor: A geoprocessing tool that calculates the nearest neighbor index 

from the average distance between each feature and its next neighboring feature. 

Basemap: A raster depicting background reference information on top of which other layers, 

either from rasters or feature classes, are placed. 

Bookmark: This saves the zoom and position of a Map’s current display in the View pane to 

easily return to it later.  

Buffer: A geoprocessing tool for creating a zone around a feature a specified distance from the 

edge of the feature. The output is a polygon feature class. If the distance is negative, it creates a 

smaller zone within each feature. 

Cell Size: The spatial resolution of a raster, i.e. the physical size of a pixel on the surface being 

viewed. 

Construction Tools: These specify the method by which the user will sketch or edit a feature. 

Dissolve: An option on some geoprocessing tools to merge the output polygons into fewer 

polygons or a single polygon. 

Favorites: Coordinate systems, geodatabases, toolboxes, and folder connections can be 

designated as favorites to make them easier to locate for future Projects. There is also an option 

to automatically add these components to all new Projects. Favorites are specific to your ArcGIS 

license and will not show up when a different user logs into ArcGIS on that same computer. 

Feature:  An individual point, line, or polygon, or a specific group of lines or polygons. Each 

feature will have one row in the attribute table of a feature class. 

Feature Class: A vector data file used specifically by ArcGIS to store features and attributes 

associated with them. A feature class has a defined geometry (point, line, or polygon) that 

cannot be changed, and only features with that geometry can be in that feature class. They are 

analogous to shapefiles used throughout GIS platforms, but with added features for use with 

ArcGIS tools and capable of holding more ancillary data for features than shapefiles. Shapefiles 

can be imported as feature classes, and feature classes can be exported as shapefiles. However, 

the export process will delete any ancillary data not supported in shapefiles.  

Feature Dataset: A collection of feature classes stored together that share the same coordinate 

systems, extent area, and theme. Unlike individual feature classes, feature datasets do not have 

a set geometry and can contain point, line, and polygon feature classes. Different geometries can 

be stored in the dame dataset. 

Field: A column in an attribute table which associates a value for a property, or other type of 

information such as a word, thumbnail image, or hyperlink, for the features in a feature class. NO
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Folder Connection:  Any folder can be added to the Folders of a Project to make it easier to 

access the data being used for that Project. These are viewable in the Catalog pane. Folder 

connections can be added to your Favorites or designated to be added to all new Projects.  

Geodatabase: An ArcGIS specific database that contains a file structure for organizing data such 

as feature classes, rasters, charts, and tables. They can only be viewed within ArcGIS, as their 

schema and file types are not recognized by other data viewers such as Windows File Explorer or 

Mac Finder. 

Hillshade: A raster function that uses elevation data to simulate the terrain with shadows 

generated for a light source specified in the function parameters. 

Intersect: A geoprocessing tool for creating a new feature class from two or more existing polygon 

feature classes, which creates polygon features based on the areas where features in the existing 

feature classes overlap and eliminates portions of features that do not overlap. Attributes from all 

input features are included in the attribute table of the output feature class. 

Layer: An element of a Map that displays data from a feature class or raster. It contains 

information on how to graphically display the data (see Symbology) and which data from the 

source to display (see Selection and Query). Layers appear in the Contents pane and can be 

copied and pasted into other Maps. They can be saved as individual Layer files that can be added to 

Maps in other Projects, but cannot be opened in ArcMap. Layer files do not contain any of the 

source data they display (see Package).  

Layout: An element of a Project that is used to create a final publishable map product, displaying 

one or more Maps and graphical elements such as north arrows, scale bars, and legends. Layouts 

are listed in the Catalog pane and can be opened, viewed, and edited in the View pane. Layouts can 

be exported in formats such as pdf and image files.  

Map: An element of a Project used for viewing, organizing, editing, and analyzing data visually. 

Maps contain layers, each displaying spatial data. They are listed in the Catalog pane and can be 

opened, viewed, and edited in the View pane. Maps can be saved in individual files that can be 

added to other Projects, but cannot be opened in ArcMap. Map files do not contain any of the 

source data they display (see Package). 

Overlay: A set of geoprocessing tools, such as Intersect and Union, that create new feature classes 

from the overlapping and combining of existing features. 

Package: A file that contains information on how data are displayed and organized, as well as all 

the source data. Layers, Maps, and Projects can all be saved as packages.  

Project:  A file that contains all information on how data are displayed and organized. Elements of 

Projects include Maps, Layouts, tables, charts, geodatabases, folder connections, favorites, 

toolboxes, and processing logs. Projects do not contain any of the source data that is being 

displayed and organized (see Package). 

Query: An expression used to specify a subset of features that meet given criteria. Queries are 

used in Select By Attributes (see Selection). They are also used in Display Filters, which are part 

of Symbology, and in Definition Query, which is found on the Data tab. Display Filters will only 

show the defined subset of features in the Layer, but all features will be processed when the Layer 

is analyzed. Definition Queries will restrict the data accessed by the Layer so that only the defined 

subset will be processed in analysis.  NO
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Quick Access Toolbar: The buttons along the top left of the ArcGIS Pro window. In addition to 

the default buttons, any other buttons can be added by right-clicking on a button on a tab and 
selecting Add to Quick Access Toolbar. 

Raster: An array of cells (pixels in image files), each possessing a numerical value and a spatial 

coordinate. Image files of all common types, as well as some planetary data specific formats, can 

be loaded into a Map. If an image lacks any coordinate system, spatial data can be added through 

georeferencing (identifying matching features) to existing rasters covering the same geographic 

area. 

Selection: A subset of features in a feature class isolated for display, organization, or analysis. 

They are highlighted in cyan in the Map and in the feature class’ attribute table. Selections can be 

created using a query, with Select By Attributes, based on a spatial relationship to other features 

with Select By Location, or by hand using the Select tool on the Map tab. 

Sketching: This describes the process of creating and editing new features by hand using 

construction tools in Create Features or Modify Features on the Edit tab. 

Snapping: An optional setting for editing found on the Edit tab that allows for exact matching of 

a vertex’s position to an existing part of a feature, such as a vertex or edge, when the mouse is 

moved to within a specified distance, or tolerance, of the object. Different types of snapping can 

be turned on or off, and the tolerance can be adjusted. Snapping can also be turned completely 

off, or temporarily suspended by holding down the space bar.  

Streaming: A construction tool for sketching lines and polygons that automatically adds vertices 

as the cursor is moved. Setting the stream tolerance to a specific distance will control how 

frequently vertices are added, though they may be added less frequently if the cursor is moving in 

a roughly straight line.  

Symbology: This controls how the data are displayed in a Map, such as color, icon size, line 

width, and stretch properties. It is accessed in a pane on the right side of the ArcGIS Pro window. 

Symbology information is stored in Projects, Maps, and Layers.  
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